


ADOLESCENTS (GRADE 9 & 10)

TIME ALLOWED

MAXIMUM MARKS

TOTAL QUESTIONS

ICATS IT CONTEST 2019

INSTRUCTIONS

1. DON'T START ATTEMPTING THE PAPER UNTIL INSTRUCTED BY THE INVIGILATORS.

2. INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT PROMPTLY.

3. CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE 

SHEET  / ANSWER SHEET.

4. RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER FROM THE FOUR GIVEN 

OPTIONS AND MARK ONLY ONE OPTION IN EACH QUESTION.

5. USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE BUBBLE SHEET. USE OF 

LEAD PENCIL IS NOT ALLOWED.

6. USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND ELECTRONIC DEVICES IS STRICTLY 

PROHIBITED.

7. EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE NEGATIVE MARKING. ONE POINT 

WOULD BE DEDUCTED FOR EVERY INCORRECT ANSWER.

8. CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR ANY REASON, AND THIS 

INCLUDES USING THE WASHROOM.

9. NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE ROOM.

10. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

A. TODDLERS (GRADE 1 & 2)

B. KIDS (GRADE 3 & 4 )

C. JUNIORS (GRADE 5 & 6 )

D. JUVENILES (GRADE 7 & 8 )

E. ADOLESCENTS (GRADE 9 & 10 / O-LEVELS)

11. ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.

12. NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK(S) OR PART OF AN ANSWER BOOK,   

 WHETHER USED OR UNUSED, OR OTHER SUPPLIED MATERIAL.

13. IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE EXAM PAPER,

 NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO ANSWER.

14. FOR INFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE FEEDBACK,

 PLEASE VISIT WWW.CATSCONTESTS.ORG

15. ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO INTERNATIONAL CATS

 CONTESTS AT INFO@CATSCONTESTS.ORG

: 90 MINUTES 

: 90

: 30 MCQS
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ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

Q1.

Q2.

Q3.

B

C

D

A

Q4.

The fourth generation computers are based on

A Transistor B Integrated circuit C VLSI microprocessor D ULSI microprocessor

You have used the keyboards so many times. You must be very conversant with 
the keys. Caps Lock is a ____________ .

How do you insert characters that are located at the top of keys on your 
keyboard, for example the question mark symbol?  

Hold down the Ctrl key whilst pressing the required key.

Hold down the Shift key whilst pressing the required key.

Hold down the key containing the character you require until the correct character appears.

Hold down the Spacebar whilst pressing the required key.

When the user clicks and drags a file to another folder on same drive, the file is:

A Renamed B Deleted C Copied D Moved

A Window key B Cursor control key C Toggle key D Modifier key
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Q5.

Q7.

Q6.

A Compiling B Debug C Coding D Bugs

A Bullets & numbering B Tables C Columns D Tab stops

Which term is commonly used to refer to program errors?

In Microsoft WORD, which feature do you use to create a newspaper like 
document?

Study the screenshot below. The button labelled Legal is circled in yellow. 
What is the purpose of this button?

B

C

D

Use this button to format the document in a specific way. The current format is Legal.

Use this button to set the paper size that the document will be printed on. The current 
paper size is Legal.

None of the options listed above are correct.

A Use this button to set the page margin type. It is currently set to Legal Margins.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q8.

A

B

C

D

Study the screenshot below of a Microsoft Word document in Print Preview.  
It looks like part of the document is cut off on the right-hand side.  Which of 
the following options will resolve this issue?

Change the paper size to A4 (8.27" x 11.69").

Change the margins to Wide Margins in the Printing area of the Backstage view.

Change the page to Landscape Orientation in the Printing area of the Backstage view.

Unfortunately this is a formatting issue and you will need to reformat the document to ensure 
it fits on the page.

Q9.

A

B

C

D

Fatima needs to number the pages of a document for her boss.  
She double-clicks in the footer of the first page of the document and types the 
words: “Page 1”. She continues to number the rest of the 27-page document in 
the same way. Which of the following do you think best describes what is right 
or wrong about her approach?

Nothing wrong with her approach, this is an effective method for inserting page numbers 
to a document.

Nothing wrong with her approach, the page numbers will automatically update when she 
exits the footer of the document.

This approach will not work unless she inserts section breaks into her document.

Her page numbers will not update automatically and all the pages in her document will be 
numbered Page 27.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

MAP OF THE WORL



Page

4 of 16

Study the screenshot below.  What does the blue wavy line underneath the 
word “it's” mean?  Choose the most correct option:

C

D

The word is used incorrectly.

None of the above options are correct.

Which of the following is the correct shortcut key to align text to the center 
of a page? 

Shift+c 

Ctrl+e 

C

D

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

equipment at the Building and their consent for any information 
computer to be shared by third parties.

“Monthly” means the first day of the month up and including month. 

“Reports” means any written record dictated or drafted by third Party’s use of it’s 
equipment.

“Payment Due” means the date effected from the date of this first become due to 
the Company;

“Income” means the net income of the Party and 15% of any course of its business;

Q10.

Q11.

A

B

There is a spelling error.

There is a language error.

Ctrl+c 

Ctrl+Shift+c 

A

B



Q12.

C

D

If she selects the text and then tick Keep With Next in the Paragraph dialogue box under the 
Line and Page Breaks tab, it will keep the lines of text and heading together.

If she selects the text and then press Ctrl+Shift+Enter, it will manually keep lines of text 
together.

B If she selects the text and then tick: Keep Lines Together in the Paragraph dialogue box under 
the Line and Page Breaks tab, it will keep the lines of text and the heading together.

A If she presses enter a few times before the heading, it will move the heading down to the 
next page.

Study the screenshot below. When reviewing this document, Lauren noticed 
that there were several instances where a heading was on a separate page 
from the paragraph that followed it.  How can she fix this and stop it from 
happening again?

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

Who we are?

ICATS is an expert group of teachers, researchers, community members and 
assessment solution developers in the fields of education and sports who 
believe that living standards of people can be improved through learning and 
creating a global competitive environment. We are dedicated to help students 
(future leaders) judge their hidden potential and employers to make informed 
decisions about people and projects.

Our Mission

To be the leading global assessment and testing organization - the first choice 

of students, teachers, and employers. 

Our Vision

To provide people an opportunity to test their educational and sporting skills 

before their application in the competitive world.
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Q13.

B

D

A Select text to copy formatting from, press the Format Painter button and use the format 
painter to paste the formatting.

Double click the format painter button and paint the text you wish to reformat with it.

Select text to copy formatting from, press the Format Painter button and press escape. 
Use the Format painter button when you wish to recreate the copied formatting.

C Select text you wish to apply the formatting to, double click the format painter and then 
paint the text with it.

Which of the following represent the correct sequence of actions to copy and 
paste formatting using the Format Painter?

Q14. Which of the following statements about the Clipboard is UNTRUE? 

B

C

D

A The Clipboard can store up to 24 items.

The dialogue box launcher in the Clipboard group launches the Clipboard.

You can only copy not cut items onto the clipboard. Cut items will not appear on the 
Clipboard.

You can use the Clipboard to repeatedly paste from the selection of items on it.

Q15.

B

D

A I would press Ctrl+Up Arrow Key.

I would press Ctrl+Page Up.

I would press Ctrl+Space.

C I would press Ctrl+Home.

In Microsoft Excel, to quickly move back to the first cell of your worksheet 
(usually A1), which shortcut combination would you use?

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q16. Study the screenshot of a section of a worksheet below.  The current selected 
cell is B5.  What will happen if the shortcut combination Shift+Space is 
pressed with this cell selected?

A

B

C

D

The entire worksheet will be selected.

The cell contents will be duplicated.

The entire Row 5 will be selected.

The entire Column 5 will be selected.

Q17.

D

A She could add the buttons for the above functions to the Quick Ribbon Status Bar at the 
bottom of the screen.

She could add the buttons for the above functions to the Quick Access Toolbar at the top 
left-hand corner of the screen.

She could add all of the above functions to the Status Bar at the bottom of the 
PowerPoint screen.

C She could create shortcuts on her desktop for the above functions to ensure quick access.

B

Laurie is making a presentation for her boss. She often needs to print, change 
page set-up and spellcheck slides. She hates having to search for these 
function buttons in different places on the Ribbon every time she wishes to 
use them. What is the solution?

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

DAY OUT IN

MONDAY

TUESDAY

WEDNESDAY

THURSDAY

FRIDAY

SATURDAY

SUNDAY 

13:02:00

13:00:00

13:42:00

13:52:00

13:58:00

14:40:00

Flying hours accumulated: 2 hours 46 minutes

FLIGHT TIMES
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Q18.

B

C

D

A

Study the screenshot below. Ahmad was busy working on a chart in Excel 
using design, layout and format options that he found on the Ribbon under 
separate similarly-named tabs. However, these tabs have now disappeared 
and he cannot find the options again. What can Ahmad do?

He needs to click on the chart for the tabs to reappear.

He needs to exit the worksheet and go back in again.

He needs to click on the Insert tab to access these options.

He needs to click on the Home tab to access these options.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q19. Study the image below this question. The Quick Access Toolbar is appearing 
below the Ribbon (circled in orange). How would you go about moving it back 
to its position above the Ribbon?

B

C

D

A This is a default setting with some versions of Excel. You need to reinstall Excel to fix 
this issue.

You can move the toolbar back up to its position by holding down the left mouse button 
and dragging it into position.

If you close the workbook and reopen it again, the toolbar will move back to its original 
position.

If you right click on it and select "Show Quick Access Toolbar above the Ribbon" it will 
move back.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q20.

Q21.

Study the image of a sample worksheet below this question. Which view 
type does this represent?

A

B

The Normal View

The Page Layout

C

D

The Page Break View

The Zoom View

Study the screenshot below.  In chart anatomy, what is the area circled in 
yellow called?

A

B

This is called the Legend of the chart.

This is called Data Labels. 

C

D

This is called Axes Titles.

This is called Plot Area Labels.
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Semester 4
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Q22.

B

C

D

A

Study the screenshot below. How can the amounts in the data labels on each 
segment of the Pie Chart be displayed as percentages in addition to the 
amounts currently displayed?

By inserting a formula to convert data to percentages in the original data set that the 
chart is based on.

By deleting the amounts and typing in the percentages in the Data Labels.

By right-clicking on any of the Data Labels, selecting Format Data Series and ticking the box 
for Percentage under the Label Options.

By right-clicking on any of the Data Labels, selecting Format Data Labels and ticking the box 
for Percentage under the Label Options.

Q23.

A

The text or numbers you type will automatically be appended to the end of the existing 
contents of the cell.

Nothing will happen. It is not possible to replace the contents of an existing cell.

What happens if you select a cell that already contains text or numbers and 
you start typing or inserting numbers?

The above action will add the additional text and/or numbers to the end of the existing 
contents of the cell.

The above action will delete the current contents of the cell and replace it with the next 
typed text or numbers.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)

B

C

D
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Q24. Study the worksheet below. How would you go about repeating the rows at 
the top that contain the title as well as the column headings (circled in yellow)? 

B

C

D

A Select the rows and press Copy, open Page Break Preview and then Paste the rows at the 
top of each page.

Select the rows and under the Page Layout tab on the Ribbon, tick the box next to Repeat 
as Header Row.

Under the Page Layout tab on the Ribbon, click on Print Titles.  Insert the row references 
into the Rows to Repeat at top box and press OK.

All of the above options are correct.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q25.

B

C

D

A James selected the header row before he pressed the Sort button and it was included.

James did not format the header row correctly to ensure it is separate from the rest of 
the data.

James did not tick the box My Data has Headers in the Sort dialogue box.

James did not highlight the header row and tick the box My Data has Headers before sorting.

Study the screenshot below. James applied a Sort to this worksheet, sorting 
alphabetically in ascending order according to Name, but for some reason the 
column title have also moved. Why did this happen?

Q26. Study the screenshot below. What formula can you use to change the case for 
the surnames in cells B2:B8 to match the case of the names in column A2:A8?

B

C

D

A The PROPER function.

The UPPER function.

The LOWER function.

The INITIAL_CAPS function.

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q27. Study the screenshot below. What is the name of this view?

A

B

The Notes View

The Presenter View

C

D

The Outline View

The Slide View

Q28. Programs that are automatically loaded and operated as a part of browser are 
known as

A utilities B plug-ins C widgets D  add-ons

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Q29.

Q30.

A trojan horse B metacrawler C worm D virus

A Pop-ups B Adware C Grayware D Spyware

Which of following is NOT a name for an item that could be a security threat 
to your computer?

It is sometimes referred to as potentially unwanted programs (PUPs), not 
obviously malicious and is not classified as a virus, but it can still be irritating 
and even harmful. It includes files or applications that can carry out unwanted 
actions, such as tracking your behaviour online or sending you a barrage of 
pop-up windows. It is a program that runs in the background on your 
computer, sending information about your browsing habits to the company 
that installed it on your computer. What is this called ______________?

ICATS IT Contest 2019 (Adolescents - Grade  9 & 10)
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Blank Page
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ICATS English Linguistics Contest 2019

National Toppers 
Student Name Father Name Grade School

MSB EDUCATIONAL INSTITUTE

RANGERS PUBLIC SCHOOL FOR BOYS

ARMY PUBLIC SCHOOL GARRISON JUNIOR

THE CITY SCHOOL CHASHMA BRANCH

THE CITY SCHOOL GULSHAN JUNIOR CAMPUS

LAHORE GRAMMAR SCHOOL LANDMARK PROJECT

THE CITY SCHOOL CANTT CAMPUS II

THE CITY SCHOOL GIRLS CAMPUS

HABIB GIRLS SCHOOL

LAHORE GRAMMAR SCHOOL

THE CITY SCHOOL TOWN SENIOR SECTION

AMATULLAH

MUHAMMAD MOHSIN     

ZAIN-UL-ABIDIN

MUHAMMAD ASIS JAVED

AYESHA SIDDIQUI

AYESHA FAISAL

ASAD IMRAN

MANAAL TARIQ

FIZZA RIZVI

LAMISAH BEHRAM KHAN

FAIZ UL HASSAN GILANI

ADNAN

WAHEED SHEHZAD 

INAM-ULLAH

MUHAMMAD SHAHEER JAVED

M. ASHRAF UL KABIR SIDDIQUI

FAISAL EHSAN

M. IMRAN

DR. TARIQ MEHMOOD

ALI ABBAS RIZVI

BEHRAM BASHIR KHAN

GHULAM UL HUSSAIN GILANI

1

1

2

3

4

5

6

7

8

9

10

City

ICATS Mathematics Contest 2019

National Toppers 
Student Name Father Name Grade School City

BILAL MALIK

MUHAMMAD RASHID

ABDUL WAHEED

M. ALI ASGHER SAMIWALA

M. SHAKIL

ASSADULLAH QURESHI

M. HARIS UMER

AJMAL IBRAHIM 

SADAT MEHMOOD

ABDUL RAUF

ABDUL HAYEE

MUHAMMAD KALEEM

AUN ALI

1

1

2

2

3

4

5

6

7

8

8

9

10

KOHSAR CHILDREN'S ACADEMY

BEACONHOUSE HAFIZABAD

ARMY PUBLIC SHOOL & COLLEGE SYSTEM SADDAR CAMPUS

MSB EDUCATIONAL INSTITUTE

DEFENCE HOUSING AUTHORITY COLLEGE AND SCHOOL SYSTEM

FFC GRAMMAR SCHOOL AND COLLEGE

THE CITY SCHOOL CHENAB CAMPUS

KIPS SCHOOL

GARRISON ACADEMY TUFAIL SHAHEED CAMPUS (SENIOR)

THE SCIENCE SCHOOL

THE SCIENCE SCHOOL

ROOTS IVY INTERNATIONAL SCHOOL IB CAMPUS

MSB EDUCATIONAL INSTITUTE

HIBA MALIK

DURYAB ZAHRA

ABDUL RASHEED

BURHANUDDIN

M. HUMMAS

EHAN QURESHI 

MAHAD ABID

UROOJ AJMAL 

MUHAMMAD SALAMAT

ABDULLAH JUNAID KHAN 

SAAD ALI HASSAN

DANIYAL KALEEM SHEIKH

AHMED ALI

KARACHI

LAHORE

LAHORE

MIANWALI

KARACHI

LAHORE

QUETTA

SIALKOT

KARACHI

ISLAMABAD

PESHAWAR

MANSEHRA

HAFIZABAD

KARACHI

KARACHI

KARACHI

FAISALABAD

LAHORE

LAHORE

ISLAMABAD

RAWALPINDI

RAWALPINDI

KARACHI

MIRPUR MATHELO
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